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Introduction
The ACT! synchronization architecture for ACT! by Sage and ACT! by Sage Premium is designed for
performance, scalability, and data integrity. The ACT! sync model is a custom implementation that
takes the best of many available Relational Database Management Systems (RDBMS) and third-party

The ACT! synchronization

sync products, rolling them into a single dynamic solution tailored to the ACT! environment and

architecture is designed for

business rules. This architecture supports both desktop database sync and synchronization with Palm
OS® and Pocket PC devices via ACT! Handheld Links1. These are generally referred to as directlyconnected devices.

performance and scalability,
supporting both desktop
databases and handheld

The implemented architecture is a combination of client-side Microsoft®.NET-managed code,

devices.

embedded in the ACT! Framework, and server-side Microsoft SQL Server® procedural objects
residing in the ACT! database. The approach leverages the underlying client-server technologies,
allowing more data- and process-intensive operations to be handled server-side, while the client-side
components define the business logic, data packaging, encryption, and data transport.
This whitepaper provides an overview of the ACT! sync model, including a description of the key
features, abilities, and concepts. It is directed at current users and potential customers seeking to
perform a functional and technical evaluation of the product. Diagrams and examples are provided
where appropriate, as well as greater detail on Internet synchronization, focusing on setup and
configuration. Also included is an overview of Handheld Device sync2.

ACT! Synchronization Overview
The ACT! synchronization experience supports the workgroup’s experience and is a database-todatabase process. It adheres to a Publisher-Subscriber model, meaning that one central Publisher
supports one or many remote Subscribers. This collection of databases is referred to as a “sync
family.” All remote Subscribers are true subsets of the contents of the Publisher database. Peer-to-

A collection of syncing
databases is referred to as a
“sync family.”

peer synchronization, which existed in earlier versions, has been replaced. It is important to note that
handheld synchronization3 (Palm OS, Pocket PC) is supported from all nodes – Publisher or
Subscriber. (Please note: Prior to ACT! 2005, ACT! synchronization was a user-to-user process.)
In an ACT! synchronization environment, one main database syncs with multiple remote databases.
Setup for the synchronization process is centralized at the main database. Once synchronization has
been set up at the Publisher database, a “pull” process is initiated by a Subscriber database. The
Publisher database, aided by a synchronization service, will be listening for incoming sync requests
from Subscriber databases.
ACT! Sync is based upon a Publisher/Subscriber Model:
1 This feature is not available in ACT!

•

Publisher provides the data.

•

Subscriber requests data, retrieves data, and submits new data.

•

The “main” database is the Publisher.

•

A “remote” database is a Subscriber.

2 This feature is not available in ACT!

•

A main database can have many remote databases.

Premium for Web.

•

Remote databases have only one main database.

•

A remote database can also be a Publisher, if one or more handheld devices are registered
to that remote.

Premium for Web.

3 This feature is not available in ACT!
Premium for Web.
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Subscriber databases are
responsible for initiating
synchronization on a
regular basis, but an
expiration period can also
be defined by the Sync
Administrator for
ACT! database synchronization is dependent on a LAN, Internet, or WAN connection and requires a

manageability.

Sync Server or service. It is designed as a background process that allows for normal use of both the
Publisher and Subscriber databases during the synchronization process.
Subscriber databases are responsible for initiating synchronization on a regular basis, but the ability
expires after a specified period of inactivity. This period is defined during synchronization setup, but
can be changed later. A Subscriber database may “estrange” itself from a synchronization relationship
with its Publisher database, either manually or implicitly. The Administrator may allow one last sync
prior to estrangement. Once estranged, the Subscriber database will not be able to re-establish the
relationship. If re-establishment of this synchronization relationship is desired, the Subscriber must be
recreated from the Publisher database.

Goals and Objectives of the ACT! Synchronization Model
The overarching goal of the ACT! synchronization model is to provide a highly reliable sync solution
that addresses the key sync scenarios a typical customer may face.
Additional objectives include:

The Sync Server is the
middle-tier component that

•

Emphasize control of data transport and data resolution.

serves as the “transport

•

Provide clear, consistent behavior.

broker” and communication

•

Design for scalability.

mechanism between a

•

Match sync environment as closely as possible to behavior of “real-time” workgroups.

•

Enforce security across all databases.

•

Avoid “anonymous subscribers.”

Subscriber and Publisher
database.

Methods of Synchronizing
Three possible Sync Servers are available in ACT! Premium (only one is available in ACT!). The Sync
Server is the middle-tier component that serves as the “transport broker” and communication
mechanism between an ACT! Subscriber and Publisher database. Users often run a Sync Server on
the machine hosting the Publisher database, but this is not necessary. It is generally recommended
that administrators run a Sync Server on one or more machines other than the machine hosting the
Publisher database to distribute the workload. This can “load balance” the network. It can also provide
a good contingency or failover plan for remote users should connectivity be unavailable for one of the
Sync Servers (i.e., traffic can be re-routed).
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Additionally, with ACT! Premium, a recommended practice is to install the Network Sync Server (and
possibly the Internet Sync Server) on each client machine that may receive a Subscriber syncing
database. The service can be defined to be a sync listener for the Publisher server/database as well. If
the prescribed Sync Server in the corporate office is down or otherwise unavailable, a remote user can
still sync by starting the local Network Sync Server and changing his/her local connection information
(on the Sync Panel in ACT!) to “point to” the local machine and port of the local running Network Sync
Server:

Network Sync Server (s)

SQL Server

Devices do not use a Sync Server. Rather, they depend upon physical connectivity and perform direct
synchronization of data with the ACT! database.
Specifications of the three possible Sync Servers:
•

Application Sync
o

ACT! must be running and the Publisher database open, “listening” for incoming

o

One “listener” at a time per machine

o

Multiple Subscriber databases can sync in parallel

syncs

•

•

Network Sync Service (ACT! Premium solutions only)
o

Separate executable run as a service class program

o

“Listens” automatically for incoming syncs

o

Publisher database may be closed, i.e., ACT! doesn’t have to be running

o

Can “listen” for multiple servers and databases

o

Multiple Subscriber databases can sync in parallel

Internet Sync (ACT! Premium solutions only)
o

Uses Microsoft Internet Information Services (IIS)

o

Separate executable run as a service class program

o

“Listens” automatically for incoming syncs

o

Publisher database may be closed, ACT! doesn’t have to be running

o

Can “listen” for multiple servers and databases

o

Multiple Subscriber databases can sync in parallel

Synchronization Architecture
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Each Subscriber database can choose its sync method and connection information. This ability
ensures that the sync family relationships and users can react to changing conditions.
Given the three-tier architecture of the Sync Server, a variety of configurations can be established
within an organization to meet the business and network needs. The following diagram depicts an
ACT! Premium setup using all three Sync Server types (Application, Network, and Internet). It’s
particularly noteworthy that the Network Sync Server can be configured and run on a Subscriber client
itself, communicating with the Publisher database. With both Network and Internet Sync Server, the
service can be installed and run on the Subscriber client, the Publisher server, or a third independent
machine hosting neither of the syncing databases.

Each subscriber database
can choose its sync method
and connection information.
This ability ensures that the
sync family relationships
and users can react to
changing conditions.

Sync Server network configuration example.
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What Is Synchronized
The easiest way to think about what is synchronized is to realize that any Subscriber database is a
true subset of the Publisher database. Actions taken on any data are always synced back to the
Subscriber’s Publisher database so that nothing “falls through the cracks.” The following items are
synchronized with an ACT! database:
•

The synchronization set: Sync Set of data as defined on page 11.

•

User and Team data: These access and security-related tables are identical in all
nodes/members of the Sync Family. The benefit is that security is consistent across all
nodes.

•

Attachments: Attachments related to the Contacts in the synchronization set (as well as
Groups and Companies) may be synchronized, but this may be limited by the options chosen
when the Subscriber database was created. A number of settings are customizable.

•

Database supplemental files: Database supplemental files (templates, queries, layouts,
and dashboards can be created at the Subscriber database, and they may or may not be
synchronized, depending on options chosen when the Subscriber database was created.

•

Schema modifications: The schema can be modified only on the Publisher database. The
modifications will be synchronized to each Subscriber database.

•

Picklist modifications: Picklist modifications may be made at any node and will
synchronize.

Once an ACT! database has been sync-enabled (whether a Subscriber or Publisher database), ACT!
detects this on database log-on and invokes a sync “File Watcher” on the database’s datastore (a.k.a.,
supplemental files) folder structure. This is true whether ACT! is running on the machine hosting the
database or on another network client machine. This process ensures that any changes made to any
database-related file are recorded in the sync transaction logs and can therefore be evaluated for
sync. It’s important to note that file modifications made outside of ACT! may be captured as well as

Sync data tracking resides
in and is performed by the

normal ACT! operations. The File Watcher includes both database-specific files, such as layouts and

database itself, ensuring all

templates, and content-specific files, such as attachments.

data modifications are
properly captured.

Devices use a Sync Set, as well, however they are specific to each ACT! user. By default, each user’s
Handheld Device Sync Set4 is defined to sync all available Contacts but can be modified to identify
specific data that each user may desire. A Handheld Device Sync Set is used to drive the content of
any/all devices for the user.

Features and Capabilities of ACT! Synchronization
Within the ACT! sync feature, a number of usability, performance, security, reliability, and scalability
factors were considered. The following features were incorporated into the product to support those
factors:
•

Subscribers can recover from a broken or incomplete sync.

•

Publisher and/or Subscriber can recover from a restored database. This is referred to as
“replay.”

•

Automatic Recovery “picks-up” incomplete synchronization sessions and will only resend
non-completed transactions, skipping those previously completed. It also recovers from

Synchronization Architecture
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dropped connections and verifies that “last sync” date/times agree; if not, it resends previous
updates.
•

Orphaned/Estranged Subscribers can become Publishers.

•

Subscribers allow only remote users to log in (the Sync Set “who list”). Additionally, any
Administrator may log in to a Subscriber database, however, not all data available to him/her
may be present.

•

Non-Administrator users can be given permission as Remote Administrator in the Publisher
database, allowing them to perform many administrative tasks on a Subscriber database,
including backup, export, and database maintenance.

•

Remote users can manage subscriptions on either the Publisher or Subscriber (“data
fishing”).

•

Transactions are logged by and stored in the database (self-contained) – SQL Server triggerbased.

•

Users receive 64-bit DES encryption, which is configurable and can be disabled via the
application config file.

•

Data packet formation is based on SyncML 1.1, an open XML-based standard adopted by
World Wide Web Consortium (W3C).

•

Two levels of sync logging are included for troubleshooting and reporting.

•

Column-level update logging and syncing are available on all tables.

•

Schema customization/definition on the Publisher is synced chronologically to each
Subscriber.

•

Last change prevails in data resolution, based on the Universal Time Coordinator (UTC).

•

Each sync session is logged for later review and troubleshooting, reporting, etc.

•

Lookup > last sync can be either date-range based or simply the last sync session. This
lookup will present results in a manner similar to results for Keyword Search functionality.

•

Administrative-style sync reports via ActDiag allow both configuration and preview
information.

Data Logging and Tracking
The mechanism for capturing and storing data changes resides in the ACT! database itself. ACT!
creates and manages custom database table triggers for all insert, update, and delete events,
providing optimum performance and consistency. Each ACT! database contains a series of sync
tracking tables containing both data changes and sync definition data (metadata). Database logging
ensures several key benefits, including:
•

Improved performance and reduced network chatter by leveraging the client/server
architecture.

•

Real-time and persistent logging of sync changes in local database control tables.

•

Durable and transactionally-bound data logging within the database – guaranteed to be there
when the user records are written.

•

Self-encapsulation of the tracking data related to the actual user data, backed-up and
restored at the same time so it’s always “in sync.”

•

Consolidated and comprehensive reporting and troubleshooting.

The database of origin is denoted on each transaction, to assist in data resolution and to provide more
granular lookups and reporting. In addition to all database tables being logged, files residing outside of
the database in the Datastore (supplemental file location) are “shadow tracked” via logging tables in
the database.

Synchronization Architecture
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Security and Permissions
Generally speaking, Administrator and Manager role users are responsible for defining the sync setup
and configuration, including the creation of Sync Sets and remote databases. Standard role users can
perform several tasks to adjust content definition. In addition, Standard role users can be given
individual permission to perform some administrative tasks while logged into a Subscriber database.
•

Standard role users and above can perform (initiate) sync from a Subscriber database.

•

Administrators and Managers can modify any Sync Set for any Subscriber database.

•

Administrators and Managers can modify any Subscription List for any Sync Set.

•

Standard role users can modify subscription Lists for Sync Sets for which they are intended
users if they have been given permission to manage Subscription Lists by an Administrator.

•

Standard role users can sync with Handheld Devices (Palm, PocketPC) if they have been
given permission by an Administrator.

Some functionality is limited on Subscriber databases:

The ACT! Sync model
depends on the ACT!
security model to properly
handle data access and

•

Though the user’s security role permits, some features are limited or unavailable on

permissions.

Subscriber databases.
•

The “Remote Administrator” permission enables the non-Administrator user to perform tasks
such as database backup and maintenance on a Subscriber database.

With regard to overall data security, the sync model depends on the ACT! security model to properly
handle data access and permissions. Essentially, the Subscriber database is a logical extension of its
Publisher database – a model of equivalency. The actions a remote user can take, as well as which
data he or she can see, are identical to those available when the remote user is logged into the
Publisher database.

Administrator Database Management
Within the Manage Databases task of the Sync Panel in ACT!, Administrators can view and manage
the Subscriber databases (including handheld devices) as needed. Administrators have visibility to
each database’s last sync date and the days remaining until expiration. Administrators can change the
status of a Subscriber database. The four possible database statuses are Active, Suspended,
Disabled with Last Sync, and Disabled.
A Suspended status option allows the Administrator to temporarily disable a Subscriber database from
synchronizing. This could be done for troubleshooting or any business-related reason as necessary. A
Suspended database can be changed back to Active, or Disabled, any time later.
The Disabled with Last Sync option lets the Subscriber database perform one last bi-directional sync,
which sets that database as disabled on both the Subscriber and the Publisher. A Disabled Subscriber
database can no longer sync with its Publisher database. To allow the database to begin syncing
again, the Administrator must re-create the Subscriber database from the Publisher.
A remote Administrator user also can “sever” the Subscriber database by changing its status to
disabled. Once disabled, the database can become a Publisher, able to create new Subscriber
databases of its own.

Synchronization Architecture
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The Database management panel allows an Administrator to view all member databases within the
Sync Family. The list includes any handheld devices, such as Palm OS or Pocket PC, that may be
registered to the Publisher or any of the Subscriber databases. This enables the Administrator to
effectively manage the definition and behaviors that affect sync and the data received by remote
users.

Technical Features and Highlights
The following is a list of technical features and specifications of the ACT! synchronization feature:
•

•

SyncML v1.1
o

Open, XML-based standard adopted by the W3C allows definition of sync packets.

o

Designed for wireless applications (low bandwidth).

o

Designed to accommodate Palm OS computing.

Transactions logged in and by the database
o

Sync-enabling the database generates triggers for each table to track all inserts,

o

Ensures nothing is missed from any source.

o

Provides optimal performance – all data stored in the database.

o

Approximately 20 tables support sync (logging and metadata).

updates, and deletes.

•

•

Column-level update logging on all tables
o

By default, only changed columns are sent for updates.

o

Design supports full chronological logging for all tables.

Multi-Level design
o

Design supports a three-level model (Publisher, Subscriber, and Publisher to
handheld device) to accommodate handheld devices.5

•

•

•

Publisher/Subscriber model
o

Uses a database paradigm, not a user paradigm as in versions prior to ACT! 2005.

o

Connected model (no store-and-forward).

o

Subscriber initiated sync (pull model).

o

Subscribers have only ONE Publisher.

o

Subscribers allow only remote users and Administrators to log in.

o

Remote users can manage subscriptions on either Publisher or Subscriber.

o

Subscriber is ALWAYS a subset of the Publisher.

o

Subscribers can recover from a broken or incomplete sync.

o

Orphaned Subscribers can become Publishers.

Sync Server
o
.Net Remoting Framework.
o
Stateless and scalable.6
o
HTTP or TCP/IP Protocol binding.
o
Integrates with IIS 4.0 and above for Internet sync.
o
Multiple servers can be configured to run on one machine.
o
Can run as a Windows® service (Network or Internet Sync Servers).
Sync client
o
.Net Remoting Framework.
o
Bound to the application context.

Synchronization Architecture
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o

Initiates the sync process (pull scheme).

•

Inside firewall/LAN connection (Application or Network sync)
o
TCP/IP.
o
Local or Wide Area Network connection.
o
VPN (Virtual Private Network).
o
RAS (Remote Access).

•

Outside Firewall (Internet sync)
o
Encrypted via 64-bit encryption, or
o
Secure Sockets Layer (HTTPS).

•

Transport assures packet delivery and auto-recovery from dropped packets.

Preparing for Synchronization
The database Administrator can take a non-syncing database and establish it as a Publisher
database. There are seven steps to deploy and sync the first Subscriber database:
1.

Enable sync on the subject database (this become the Publisher database).

2.

Start a Sync Server to accept incoming syncs for the subject Publisher database.

3.

Create a Sync Set (described below). This determines “who” and “what” will sync.

4.

Create a remote database. Set the options as desired in the UI panel. Multiple remote
databases can also be created at one time.

5.
6.

Distribute the resulting remote database file (.RDB) to the targeted machine.
Apply that .RDB file via ACT! using the File > Restore > Database menu item. Or, simply
double-click the .RDB file to automatically deploy the Subscriber database onto the machine.

7.

Verify the Sync Server connection on the Subscriber, then sync.

At this point, you can create and deploy additional sync sets and/or remote databases by repeating
steps 2 (or step 3 if you decide to use the existing sync set definition) through 7 above. A key to sync
setup is understanding and defining a sync set.

Understanding and Defining a Sync Set

A Sync Set defines the

There are two general types of Sync Sets:

criteria of what will

•

Regular Sync Sets

synchronize and the

•

User Handheld Device Sync7 Sets

intended users of the data.

Regular Sync Sets must be defined and managed by an Administrator, while Handheld Device Sync
Sets are per-user and can be managed by the user themselves without Administrator intervention.
A Sync Set is the defined set of data in a database that is designated to synchronize to one or more
Subscriber databases. When setting up synchronization at the Publisher database, the Administrator
defines the Sync Set and uses it to define a Subscriber database during its creation. The Sync Set
may be used for more than one Subscriber database. The Sync Set dialog boxes and behaviors are
similar to Group and Company query definitions – the Sync Set is essentially a collection of contacts.
A special, isolated type of Sync Set is the Handheld Device Sync8 Set. Each ACT! user has one of

7 This feature is not available in ACT!
Premium for Web.

these Sync Sets available to them, and by default is created to subscribe all available Contacts. Just
like regular Sync Sets, the user can limit and specify the Contacts desired based upon criteria. These
Sync Sets can either be managed in the ACT! Sync Panel.

Synchronization Architecture
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The contacts available to be included in the Sync Set are limited by the accessibility of those contact
records to the intended users of the Sync Set. If none of the “intended users” has access to a specific
contact, it isn’t available to be part of the Sync Set. If at least one of the “intended users” has access to
a contact, it is eligible to be included in the Sync Set. A Sync Set may be further defined by applying a
query definition to the contacts eligible to be part of the Sync Set. In the criteria definition interface, the
user can create a set of criteria using the query builder or open a saved Group, Company, or
advanced query (.QRY file). Contact records also may be included (beyond the bounds of the query
definition) using a subscription list.
Any user belonging to the Administrator or Manager Role can alter a regular Sync Set at any node of
the sync family. However, Standard role users have the ability to control the Subscription List from the
Subscriber database node by manually subscribing additional accessible Contacts which do not
currently meet the Sync Set criteria. At the Publisher database, an Administrator or Manager can
perform a Lookup of a Sync Set for each Subscriber database.

Three major components of the Sync Set
The three components of the Sync Set are the “who list,” query, and subscription list.
1.

“Who list” (a.k.a. “intended users”)
o

List of intended, remote users who can log in to Subscriber database.

o

At least one user must have a Standard role. Please refer to the Help topic “What

o

Constrains which Contacts are available to be synchronized; only those Contacts

Are User Roles and Permissions?” for more information.
accessible to at least one member of the “who list” are available for
synchronization.
2.

Query (optional)
o

3.

Dynamic, criteria-based, query definition of the set of Contacts to be synchronized.

Subscription List
o

Additional “hand-picked” Contacts to be synchronized.

o

Allows user to select Contacts that fall outside the query definition to be
synchronized.

Items that always sync:
•

Schema (from Publisher database to Subscriber ACT! databases).

•

Database preferences, such as name separators, scheduling, etc.

•

User data, including passwords, roles, permissions, etc.

•

Group and Company records, including query definitions and extended data.

•

Opportunity records

•

Database configuration and definition data lists, including Custom Activities, Custom
Priorities, Custom Clearing Types, Events, Activity Series, Opportunity Stages, and
Processes.

Items that the user may choose to sync:
•

Database supplemental files, including letter templates, report templates, layouts, and saved
queries specifically “belonging” to the Publisher database.

•

Attachments

•

Only those documents associated with Contact records in the Sync Set, any Group,
Company or Opportunity records.

•

Document tab items.

Synchronization Architecture
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Items that do not sync9:
•

Personal supplemental files
o

Files stored in the traditional “default locations” paths.

o

Letter templates, report templates, layouts, etc., which do not “belong” to any
specific database.

•

Settings and Preferences stored locally

•

The ACT! e-mail database.

o

Including settings for navigation bars, toolbars, menus, and column customization.

Sync Set example:
Database contains 1,000 total contact records.
•

•

•

(A) “Who list”
o

Three users identified as intended remote users (Moe, Larry, and Curly).

o

500 possible contacts are accessible to at least one of the three intended users.

(B) Query
o

State = “CA”.

o

Reduces the 500 available candidates to 100 that meet the criteria.

(C) Subscription list
o

Allows users to select additional contacts that fall outside the query for

o

2 customers in Oregon.

o

2 vendors in Texas.

synchronization.

•

Total Sync Set = 104 Contacts.

9 Handheld sync is not available in ACT!
Premium for Web.

Synchronization Architecture
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Subscription List
•

List of all contacts in a Publisher database (within the Sync Family) to which a particular user
has access, includes “core” fields Name, Company, and Phone.

•

User may designate individual contacts to sync, regardless of query definition.

•

Allows ACT! Standard role users to “data fish,” that is, request additional contacts that do not
meet the Sync Set criteria.

•

Users can modify the subscription lists of any Sync Set where they are listed in the “who list”.

•

May be “reset” to return the Sync Set to the base query criteria.

HTTP (Internet) Synchronization
The ACT! Internet Sync Server enables users to synchronize data over the Internet outside a firewall.
This means users do not need to connect to their workplace Local Area Network (LAN) to sync their

The Sync Server can listen
to incoming requests for

data. This differs from the other two sync server configurations in ACT! (Application sync, which uses

several Publisher databases

the ACT! application as the server, and the Sync Service, which uses an installed NT service). These

at a time, just like the

configurations require users to be logged on the network. The firewall protects the Publisher database,

standalone ACT! sync

which can be physically located at a protected site inside an organization’s firewall, while the remote

service.

users can sync their data from unprotected locations using the World Wide Web. All the sync
communication is performed over standard network protocols and is protected by data encryption
algorithms to prevent eavesdropping.
To set up HTTP Sync, the minimum requirement is a Web server; in this case Microsoft IIS (Integrated
Information Server). Currently, IIS is the only Web server that allows HTTP sync to occur. ACT!
Premium includes the installer for the Web server, which configures IIS to run Web Sync Server. The
clients connect to Web Sync Servers using URLs in the form used for conventional Web browsing.
The Sync Server can listen to incoming requests for several Publisher databases at a time, just like
the standalone ACT! sync service. The Web servers can be managed to accept incoming syncs for
various Publisher databases, and these databases can be installed on different machines as the Web
servers.
A Web server listens to the incoming requests on port 80 of the machine. Traditionally, corporate
firewalls disallow any outside communications on any ports other than 80, to prevent software attacks
on sensitive data. However, corporate Web sites are usually hosted on port 80 in demilitarized zones
on the network. These zones are prone to outside attacks but are kept safe by Web server security.
ACT! sync uses similar technology to allow syncing outside software firewalls.
To configure the IIS Web server, the ACT! Installer creates a virtual directory and installs the
necessary files for syncing. These files are .NET-dependent and require the .NET Framework to
reside on the same machine as the Web server. An NT administrator log-on is required to install and
run the Web server to access the shared SQL Server instances on the network. Administrators can

10 Scalability will vary based on

also log on to their machines and manage the Web servers using Microsoft Management Console
(MMC). To provide scalability10 and load balancing of the Sync Servers, a clustered configuration of

hardware and size and usage of your

Web servers can also be used. By managing the Sync Server information, remote users can sync their

database. Published minimum system

client databases seamlessly to Publisher databases using either a Web server or an NT service. For

requirements found at

example, an NT service location may be \\ACT_NTService whereas Web sync server location may be

www.act.com/2010systreq are based on

http://www.mycompany.com/ACT_Virtual_Directory. Since the Web server always listens on port
80 by default, users do not need to enter the port number for the Web service.

single user environments. You must
purchase one license of ACT! per user.
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Web Sync Server is a lightweight component with limited ability to manage data on its own. It has a
limited UI to manage the list of the syncing Publisher databases. It does not contain any ACT!
application features. To view changes made to Publisher databases, users need to log on separately
using ACT!. A Web server’s only purpose is to act as a channel between the syncing Subscriber and
Publisher databases.
Requirements
•

ACT! Premium.

•

Microsoft IIS 5.0 and higher.

•

Microsoft Windows 2003, XP (Pro recommended).

•

Internet connectivity.

Web Server setup
•

Port 80.

•

“ActInternetSync” virtual directory.

•

fport.exe/ActDiag.

•

cliconfg.exe (Windows\System32).

•

o

Alias “<computer name>\ACT7” (same as server).

o

Server name “<computer name>\ACT7”.

o

Uncheck dynamically determine port.

o

Port number “<port>” (from fport.exe or netstat).

Integrated Windows authentication.

Internet Sync Setup
To address the challenges of connectivity within your organization, the ACT! Sync Server can be
configured within the guidelines of an IT organization. To limit public exposure, don’t set the SQL
Server database server(s), but rather the machine(s) running the appropriate Sync Server(s). The
following illustrations show two examples of the mobile user with a Subscriber database on his/her
notebook computer, who needs to connect to a Sync Server back at the corporate office.

Example 1: Internet Sync setup – single firewall
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Example 2: Internet Sync setup – multiple firewalls

Advanced Troubleshooting Support
Internal and external logging, sync reports, and a sync rebuild ability are available for diagnostics and
troubleshooting within the ACT! product and the accompanying ActDiag utility.

Sync Logging
Two levels of sync logging are available in ACT!. These logs are useful for both reporting and
troubleshooting purposes. One is stored inside the database and the other resides on the machine’s
hard disk.
Sync High-Level Logging

This is stored in an internal database table. It shows all sync sessions for all Subscribers
when viewed on a Publisher database, or just the Subscriber itself when viewed on the
Subscriber database.
This Sync Log can be viewed via the Tools > Synchronization Panel > View Sync Log menu
item.
Sync Low-Level Logging

This is used primarily as a troubleshooting technique. By default, errors are logged here to
the resulting SYNCLOG.XML. You can modify the application and/or Sync Server .config file
to increase the degree and verbosity of the logging. This is recommended only if ACT!
Technical Support suggests it to help identify and resolve problems.
You must modify the applications .config file when changing the logging switch values. The
.config file needs to be modified on both the remote client machine for the ACT! application
(Act10.exe.config) and the machine running the Sync Server. You may need to modify a
different .config file as noted below, depending on which of the three possible Sync Servers
you are running.

Synchronization Architecture

16

ACT! by Sage
To enable sync logging: [SYNCLOG.xml]:
o

Internet Sync Server – web.config.

o

Network Sync Server – Act.Framework.Synchronization.Service.exe.config.

o

Application Sync Server – ActSage.exe.config.

The Microsoft Web site contains the description and behavior of these values.

ActDiag
ActDiag (with the file name ActDiag.exe) is a diagnostic and utility tool that is installed with your ACT!
installation. The following configuration and diagnostic reports are available to run per database:
•

Sync Configuration Report.

•

Sync Preview Report.

•

Sync Database History Report.

Additionally, a “Rebuild Sync Objects” repair utility is available if it is suspected that any structural or
metadata objects or information is incorrect. Typically, this would seldom (if ever) be necessary, but it
is there to help the user resolve problems.

Glossary of Terms
Application Sync – the Sync Server available in both ACT! and ACT! Premium. Invoked via the Tools
> Sync > Accept Incoming Syncs menu item, it processes incoming sync requests from Subscriber
databases. This option is only enabled on a sync-enabled Publisher database. When started, it listens
for incoming sync requests for the current database only.
Evil twin – a second copy or deployment of a remote database (.RDB file). A Subscriber database is
unique. Once created, an .RDB file could be distributed to multiple machines and restored. ONLY the
first Subscriber database to successfully sync with the Publisher establishes the “contract” between
the Publisher database and that Subscriber database name. Subsequent attempts to sync that .RDB
file deployed onto a different machine are rejected by the Publisher and considered to be an “evil
twin.”
Handheld Device – also known as a handheld computer, "smart phone" or simply “handheld”. A
pocket-sized computing device typically having a display screen with touch input and/or a miniature
keyboard. Examples include, Windows Mobile®, BlackBerry®, and Apple iPhone™.
High-water marks – refers to the “last success” values of a database. These values represent the
“starting point” for the next sync session.
Internet Sync Service – available with ACT! Premium only. Installed separately, it requires Microsoft
Internet Information Services (IIS). This service lets the user “register” one or more SQL Server
machines and databases, for which the server will listen for incoming sync requests.

Synchronization Architecture

17

ACT! by Sage
Network Sync Service – available with ACT! Premium only. Installed separately, it runs as a serviceclass process. It contains a UI form that lets the user “register” one or more SQL Server machines and
databases, for which the server will listen for incoming sync requests.
Parent – see Publisher.
Publisher – a database from which one or more other databases are created. A Publisher database
does not initiate the sync process and is a superset of all subscribed databases. Synonymous with
Parent database.
Remote – see Subscriber.
Replay – if the Publisher or Subscriber database has been restored from a previous backup, the sync
process will detect this. It will attempt to reset the “high-water marks” as necessary (and as available)
and “replay” the transactions that have occurred since the backup.
Subscriber – a database that was created from a Publisher. A Subscriber database has only one
Parent (Publisher) database and is responsible for initiating the sync process. Synonymous with
Remote or Child database.
Subscription List – a by-product of the Sync Set. Contains a list of contacts available to the users of
a Sync Set (the “who list”), identifying subscribed contacts and non-subscribed contacts. Contacts are
subscribed automatically (via query) or manually (via user selection). Any non-subscribed contacts can
be manually subscribed by the user. This causes the contact and all extended data to be retrieved
during the next sync session.
Sync Log – a database table containing sync-relevant events. These events include creating and
changing the Sync Set and Subscriber database, the steps in each sync session, and the resulting
record counts and statistics. This sync log is viewable from the sync panel.
Sync Service – available with ACT! Premium only. Installed separately
Sync Set – a logical grouping of information that contains contact subscription query criteria and the
“who list,” essentially defining who and what will sync. A Sync Set can define and drive the contact
subscription content for one or more remote (Subscriber) databases. Handheld Device Sync Sets
specifically define syncing with personal devices (see Handheld Device definition above).
Who List – identifies the list of database users targeted by the contact subscription list in a Sync Set.
In addition, this is the list of users who are allowed to log on to a remote (Subscriber) database using
the Sync Set.
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References and Related Links
Sage has created and maintains a Knowledgebase Web site that addresses many known issues
regarding ACT!. Several helpful sync-related articles can be referenced to a specific feature of the
product. In addition, you can access the Knowledgebase directly from the Welcome page in ACT!
2010.
You can access the ACT! Knowledge Center at:
http://www.act.com/support/technicalsupport/knowledgebase/
To search relevant articles after logging in, select the “ACT! by Sage” Product and type in “Sync” for
the Search Text.

Important Note: Review ACT! system requirements at www.act.com/2010systreq. You must purchase one license
of ACT! per user. Scalability varies based on hardware, size, and usage of your database. Compatibility: Due to
new functionality available in ACT! 2010, we strongly recommend contacting your add-on product provider to
confirm compatibility. Using versions of the add-on product that have not been confirmed compatible by the vendor
may result in features behaving differently or not appearing within ACT! 2010. Visit www.actsolutions.com or contact
your add-on product provider to help determine compatibility.
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